
 

About MediaShout 7 
 
 
 

MediaShout 7 is the newest and most exciting presentation software in the market. Created by pastors, techs, 
and volunteers like yourself, MediaShout 7 focuses on three major components to give you the best experience 
possible – stability, speed, and ease of use. Everything that has been poured into MediaShout 7 has been 
approached from those three perspectives so that no matter your skill level or expertise, you can be successful 
with MediaShout 7. 

 
As the originator of Church Presentation Software, the team at MediaShout is here to make sure you are able to                    
share the Gospel of Jesus effectively week in and week out using our newest tool. If you ever have questions                    
or issues, please do not hesitate to contact our team. For the best way to reach us, visit 
w ww.mediashout.com/support (https://www.mediashout.com/support) and choose one of the many ways we 
make ourselves available to serve you and your ministry. 
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What’s New in MediaShout 7 
 
 
 

If you are a long-time user of MediaShout, then you will be happy to know that we have included many of the 
most popular features from our past versions, but we have listened carefully to your feedback over the years and 
have improved every single feature in some way to better serve you and your ministry. 

 
Our largest investment was creating all new code for the entire MediaShout 7 product, and that included 
moving to more modern programming languages and tools. This has opened a whole new world of possibilities 
for us to continually improve the product over time. Is there some feature you would like to see, or a challenge 
in your technology ministry that no one has provided a solution for yet? Let us know, and we will see what we 
can do. With our new platform we have a much easier way to add features to the software. 

To ensure that MediaShout 7 looks as good on the outside as it functions on the inside, we employed an 
amazing User Experience / User Interface (UI/UX) expert to help ensure that the program is laid out in a way 
that makes sense and is easy to follow—even for new users. Plus, this developer is also a worship leader at his 
church, so he understands what you want and need in a ministry environment. 

 
Finally, we’ve added some great new features that no one else has, such as: new Key Controls, a new Presenter 
View, and the new Sermon Builder Wizard, just to name a few. The last of those three, Sermon Builder, is a new 
first-of-its-kind tool to help Pastors build their sermon slides in MediaShout faster than any other program— 
including PowerPoint! And we already have plans to continue adding some of your favorite third-party 
integrations and tools as we move forward. 

 
MediaShout 7 has been designed for the user—by users. We are excited about all that’s new, and we look 
forward to even greater things yet to come! 

 
Oh, and if you want to check out a list of all the new things in MediaShout 7, visit our What’s New 
(https://www.mediashout.com/whats-new-in-v7/) webpage. 

 
 

 
 

 
 
 
 

 
 

https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/
https://www.mediashout.com/whats-new-in-v7/


 

Installation and Setup 
 
 
 

Installation of MediaShout 7 is very easy. Simply download (https://mediashout.com/download/) the latest build 
to your computer and run the file. The installer will begin and walk you through the steps for installing the 
program. In almost all cases, the recommended defaults will be perfect. For Advanced Users, you can change the 
install location of the software and create a desktop icon among other things. 

 
NOTE: For users who do not have the C++ 2017 Redistributable (x86 and x64), MediaShout 7 will also install those as part 
of the install process. Don’t worry if you don’t see those appear; it just means you already have them installed. 
 
Uninstalling MediaShout 7 is very easy, too. Simply go to the Window’s Add or Remove Programs on your 
computer and you can remove MediaShout 7. If you forget to Deactivate your license, the uninstaller will ask 
you if you want to Deactivate before it completes the uninstall so that you can use the activation on another 
computer. If you plan to reinstall on this computer, then simply choose not to deactivate. 

 
Setting up MediaShout 7 correctly the first time you run it is very important to having a great experience with 
it. Once MediaShout opens, you will be presented with the Tip of the Day. You can close that and then click the 
Settings Menu to open the Settings Window. Here, you will want to do a few things: 

 
1) Set your Save Folder (if you don’t want to use the default) 
2) Set the Library Folders for Images and Videos 
3) Finally, setup your preferred resolutions and screens 

 
If you have a single monitor connected to your computer for the moment, then you can leave the Main and 
Stage Display dropdowns alone. 
 
If you have two or more monitors connected, you need to define which is your Control Screen for your 
desktop monitor and which is the Main Display for the audience to see, and possibly which is the Stage 
Display for the confidence monitor if you are using one. 
 
In the Settings and “Display Settings” area, you will see a drop down menu where you can pick Display 1, 2, 
or 3 (as many as you have connected) for the Main Display and Stage Display. Note that these numbers may 
not always match the numbers Windows assigns to your displays, since a different protocol is used by 
MediaShout. The best way to find out which one is which is by trial and error using the information below: 
 
The F2 key (Function + F2 on a laptop) will shut off the output to the Main Display if you have a cue fired 
(we’ll talk more about how to fire cues later), and the F3 key will shut off the output to the Stage Display. If 
you fire a cue and find the output covers your Control Screen, you can press F2 to turn the output off, then go 
to the Settings and Display Settings to try a different setting for your output screens, and keep doing this until 
you find the right selection. (There should be a maximum of 3 options). 

 
For detailed instructions of the screen setup, including how to prepare your Windows Display Settings before 
even opening MediaShout, we do have the following link to help: 

  http://www.mediashout.com/screens 
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That’s it! You are ready to get started building your first presentation in MediaShout 7. On the Welcome Screen you will see 
quick links on the right to tools and websites designed to help you be successful with MediaShout 7. 

 
 
 
 
 

 



 

Quick Start Guide 
 
 
 

Getting started with MediaShout 7 is really easy! 
 
The first time you open MediaShout 7, you will be prompted to either do a trial or activate your license. If                     
you have a license code, go ahead and activate it now. If you haven’t purchased a license code yet and just                     
want to try the program, choose Trial Mode. 

 
After completing the Trial or Activation wizard, you will be presented with the Tip of the Day. Closing that 
window will show you the Welcome Screen. Here you can open any of the pre-loaded scripts we have created 
for you such as the Introduction Script or the Sunday Service Template Script. To create your own script, read on.  
 
Creating A Script 

 
● Click “Create a New Script” or press CTRL+N. Now you are looking at the Control Screen with a Blank 

Script open. 
 

● You now need to add some cues to your script. Let’s start by clicking the Insert Blank Cue icon in the 
Ribbon. 

 
 

 
 
 
 
 
 
 

The Insert Blank Cue icon in the Ribbon. 
 

● Let’s give our new Cue a name and then we will see it in the Script on the left. We can now add Objects 
to it (like Text Boxes, Images, and Videos). 

 
● Let’s click the Insert Text Box icon in the Objects section of the Ribbon and a text box will appear on 

our Page in the Edit Area. You can now replace that text by selecting and typing in the text box. You can 
also resize the text box by dragging the corners or move it around your Edit Area. 

 
● The Edit Ribbon right above the Edit Area will also give you contextual controls based on what 

object is selected in the Edit Area. Since we have a text box selected, we will see controls for 
Font, Size, Color, Alignment, and much more. Edit as you desire. 

 
● Let’s now add a background to this Cue (note, the background will carry over to all of your pages within 

this cue). Go to the Layers Tab on the right and under the Layers Heading, click the Background button 
(underneath the Text Layer listed there). 



 
 

● From here, you can choose a color for the lowest layer or place an Image or Video as the Background. 
Once you have what you want, just click the Save Changes button in the bottom right. 

 
● Finally, let’s add an image object to our page. Click the Insert Media Files icon in the Objects section of the 

Ribbon and you can now choose an image or video file from anywhere on your computer. Find an image 
(.jpg or .png file for instance) on your computer and select it to insert it. 
 

● You will notice that you have a different set of controls in the Edit Ribbon now because you are selecting 
an image. Move and resize the image as you prefer. 
 

● You can also adjust whether the image object is above or below the text object by dragging it up and down 
in the Layers Tab on the right. 
 

● We have now completed creating our first Cue from scratch. Let’s move on to 
Lyrics.  
 

Inserting Lyrics 
 

 

 

 
 
 
 

 
The Insert Lyric icon in the Ribbon. 
 

● Click the Insert Lyric icon in the Ribbon. This will open up to your Lyric Library.  

● For now, let’s just select one of the Lyrics in the All Folder of My Library. You can see a preview of the 
lyric on the right. 

● You can also change the mode to list view by clicking the icons in the upper right of that window. 

● If you want to add additional stanzas, change the order, or repeat stanzas, you can configure all of that here. 

● Let’s just leave it as-is for now and click Insert Lyric. The Lyric cue has been added to our Script and is 
ready for editing. We could insert more lyrics now, but let’s just close this window. 

 
● In the script, you will see multiple pages for your Lyric, depending on the number of stanzas. 

 
 
 
 



 
● Just like before, you can edit the Text as preferred, but one key difference is that the text boxes are all                     

linked. If you want to change the font, size, location, etc. on all of the lyric text at the same time,                     
simply make the change to one text box and then right-click and choose “Apply Formatting to                
All Pages” and this will change all of the Lyric Text to match. It’s an easy and fast way to adjust                     
everything for this one Lyric. 

 
● We can also add a background to this Lyric just like we did before by going to the Layers Tab and                     

clicking the Background button. This will apply the selected Background to all pages of this Lyric. 
 
 

Inserting Scripture 
 

 

The Insert Bible icon in the Ribbon. 
 

● Click the Insert Bible icon in the Ribbon to get started. 
 

● When the window opens, you can choose from any of the available Bible Translations in the top left. 
Then choose a Book and a Chapter. You also have the ability to create two Bible Translations on the 
screen at the same time using the Dual Bible function, but we will save that for later. 

 
● Once you have the Chapter selected, the center window will populate with the verses of that Book and 

Chapter. You can click on any number of boxes next to the verses (even non-sequential verses) to select 
them. You will see the reference change in the top as your selection changes. You can also edit your 
selection by editing the reference at the top. 

 
● Once you have your verses selected, you will see a preview of them on the right. Click the Insert Bible 

button to add this Cue to your Script. Like Lyrics, we can add more scripture, but for now, let’s close the 
window. 

 
● You can now edit the Bible Cue just like you did a Lyric Cue, including font, size, location, background, 

etc. and right click to “apply formatting to all pages” if desired. 
 

Playing Your Presentation 
 
Once you are satisfied with your Cues, then let’s play or “Fire” your presentation! 
 

● Usually, the best thing to do first is switch the tab section on the right from Layers to Viewers. This way, 
you can see what you are playing out to the screen. Since we aren’t working with the Stage Display at this 
time, switch the bottom viewer to Main Display Next.  
 
 



 
You may also notice a resolution setting under the viewers at this point. For our first script we have 
created, this isn’t an issue, but for future scripts, you will want to make sure you configure your resolutions 
correctly before you build your content. 

 
● On the left side of your Control Screen, where your Script is, you have your three Cues you created. To the 

right of each Page under a Cue is a Play Button that will appear when you hover over the Page. Click that 
for Page 1 of your first Cue. Now you can press F9 to go forward through your presentation or F7 to go 
backward, or continue clicking with your mouse to fire pages at random. You will see it change in your 
Viewers as you go through your presentation. You may also use the spacebar to advance, but be sure your 
cursor is not sitting on one of the controls to prevent the space from toggling that function. 
 

● Another option is to enter into Presenter View, which will flip the space in the middle of the control screen 
from the Editor to an area with thumbnails of all your Cues and Pages—perfect for running your services. 
 

● To access Presenter View, use the toggle switch toward the top right of your screen, or press Ctrl + Alt + V. 
You can then use the zoom slider to make the thumbnails larger or smaller, or change to a list view to see 
more of  your content at once. 
 

● In Presenter View, you can double click any slide to immediately fire it to the screen, and just like in Edit 
view, use F7 and F9 to go backwards and forwards, or the spacebar to advance. 

 
 
That’s it! In just a few minutes, you built a Script with different Cues and played it. Of course, there is a lot more 
to MediaShout 7 than just this and the more you do, the faster you will get. If you want to learn more, we 
encourage you to keep reading this User Guide (we will go into great detail), open and play through the included 
Scripts in the program, and check out our training videos. Of course, if you get stuck on anything, just let us know 
and we would be happy to help. 
 
 

 
 

 
 

 



 

Terminology 
 
 
 

There are lots of words and terms used in MediaShout 7 and in this User Guide. Consider this page your source 
for figuring out exactly what that word or phrase means if you don’t know and feel free to bookmark it as you 
need. 

 
Control Screen 
 
The Control Screen is the area where you work on editing and playing your MediaShout 7 Script. In most cases, 
this is the screen in front of the operator. The Control Screen has different areas for setting up your presentation, 
editing elements, and customizing the view for your operation. 

 
Main Display 
 
The Main Display is the screen that the audience/congregation sees. This will usually be a full-screen display of 
your presentation on a second video output of your computer to your Projector, TV, or Video Mixer. 

 
Stage Display 
 
The Stage Display (also known as the Confidence Monitor or Foldback Monitor) is an optional display that is                  
used for the worship team or speaker on stage to give them additional notes, information, or a view specific                   
to their needs. This is a full-screen display on a third video output of your computer. 

 
Script 
 
The Script is your presentation. The Script is a collection of one or more Cues (lyrics, scripture, announcements,                  
etc.) that make up your entire presentation. The Script is along the left side of your Control Screen. You can                    
have multiple scripts open in MediaShout 7 at the same time. When you save your presentation, you are saving                   
an 
entire Script as the file (.sc7x) on your computer. 

 
Cue 
 
A Cue is the main element that make up a Script. One or more cues make up an entire presentation script. A Cue 
can consist of a single Page or many Pages that each contain any number of Objects. When looking at your 
Script in the Control Screen, the main elements are Cues. 

 
Page 
 
A Page is a section of a Cue. Each Page contains any number of Objects (such as text boxes, images, videos, 
etc.) and this is the building block of your presentation. When working in the Edit Area, you are working on a 
specific Page in your Script. 

 
Objects 
 
These are the individual elements found on a Page. Objects can be Text Boxes, Images, Videos, Audio Files, and 
other things. Some Objects even have special properties for certain uses (like Key Objects). To summarize how 
they all work together: 

Control Screen -> Script(s) -> Cue(s) -> Page(s) -> Object(s) 



 
 
Layers 
  
  Objects are arranged on a Page in Layers. All Objects will sit somewhere on the page either in front of or behind 
other objects. The lowest layer is always the Background Layer (which by default is the color black) whereas 
Key Objects are always the top layer. You can see the Layer order by going to the Layer Tab on the Control 
Screen. 

 
Preset 
 
A Preset is a collection of settings for an individual Object. These settings can be applied to like-objects (i.e. an 
Image Object Preset can be applied to other Image Objects) and can include the size, font settings (if a Text 
Box), X and Y Location, and much more. 

 
Transition 
 
A Transition is how an Object or Page enters or leaves the presentation. The most often used Transitions are Cut 
(where the Object/Page immediately appears/disappears) or Dissolve (where the Object/Page fades in/out over a 
user-determined amount of time). When using a Page Transition other than Cut, all Objects that appear with the 
Page will use that transition (no matter what is set for the Object). 

 
Fire 
 
Firing a Page simply means you are playing it out to the external displays for the audience to see. Only when 
you Fire a Page does it appear to the audience. This allows the operator to be editing any Page in the Edit Area 
while a completely different Page is being Fired. 

 
Plug-In 
 
A Plug-In is an optional add-on that allows you to add functions to MediaShout 7. Most Plug-Ins are free to 
download and use with a licensed copy of MediaShout 7. Utilizing Plug-Ins allows you to truly customize 
MediaShout 7 with the tools you want or need without a lot of extra stuff. As you get used to using the 
program, you can expand its capabilities by adding additional Plug-Ins. 

 
 

 
 

 
 
 
 

 
 



 

Control Screen 
 
 
 

The Control Screen is the screen the operator sees on their computer monitor. This is the heart of MediaShout 7 
and where edits are made as well as how Pages are Fired to the screens. Understanding the layout of the Control 
Screen is important, but know that as you get comfortable with MediaShout 7, you can adjust certain elements 
of the layout to better suit your ministy’s needs. 

 
Menu Bar 
 
At the very top of the Control Screen is the Menu Bar. The Menu Bar will give you access to common tools, 
such as Opening a Script, Printing/Exporting, Changing Settings, Inserting of Cues and Objects, View Options, 
and a great number of Help Resources. 

 
Main Ribbon 

Below the Menu Bar is the Main Ribbon. The Main Ribbon holds icons for quick insertion of various Cues as 
well as insertion of Text Box and Media Objects. As new features are added to MediaShout 7, this Main Ribbon 
will grow with new icons. 

 
Script Area 
 
The left side of the screen is the Script Area. Above the Script Area is a tab with the Script Name. You can have 
up to 10 Scripts open at one time (each with its own tab). Many users choose to build a Script for 
Announcements, another Script for the Worship Service, and a third Script for the Pastor’s Sermon. Each Script 
is made up of any number of Cues. Each of these Cues will have at least one Page (that can be Fired) as well as a 
place to Comment on the Cue. 

Edit Area 
 
The middle of the screen by default is the Edit Area (this can be toggled – see Presenter View). This area is 
where you build each individual Page of the Cues in your Script. When selecting an Object to Edit, the Edit 
Ribbon (immediately above the Edit Area) will change options based on the type of Object selected. You can 
also apply Presets to Objects here along with other FX (Effects) settings. 

Presenter View 
 
The middle of the screen where the Edit Area is can also be toggled to a Presenter View. This area gives you the 
ability to see more of your Script, Cues, and Pages for easier Playback while removing the Editing capabilities. 
This is a great tool for using with volunteers or first-time operators, so they don’t have to worry about editing 
things by accident. You toggle this by going to the View Menu > Mode > Presenter View or using 
CTRL+ALT+V. 

 
Layers Tab 
 
The right side has three tabs for various controls and settings. The first tab is the Layers Tab. This tab gives you 
the ability to rearrange Objects on the Page, change the Background for the Cue, and even hide Objects from 
displaying at all. 

 
 



 
Library Tab 
 
The second tab on the right side is the Library Tab. This tab has quick access to commonly used media files that 
you can simply drag and drop into your presentation. The contents of the Library Tab are changed by adjusting 
the Library Folders in the Settings Menu at the top. 

Viewers Tab 
 
The last tab on the right side is the Viewers Tab. This tab allows the user to see exactly what is being Fired to 
various outputs. The top Viewer shows the current Main Display (what the audience is seeing). The bottom 
Viewer can toggle between what is on the Stage Display or what is coming up next on the Main Display. 

 
Plug-Ins 
 
Plug-Ins are the icons found along the right side of the Control Screen. These do various special functions, like 
Transitions, Key Objects, Cue Library, and more. As more Plug-Ins are developed and installed by the user, they 
will appear along this bar. 

 
 

 
 

 
 
 
 

 
 



 

Basics of Editing 
 
 
 

Editing in MediaShout 7 is designed to be very easy and intuitive. If you want to edit something, you simply 
select the Object you want to edit in the Edit Area and the Edit Ribbon will dynamically change to give you 
access to the most common tools for the Object. It’s that easy! But let’s dig into each type of object and some of 
the controls you have in the Edit Ribbon. 

 
Text Objects (Text Box, Lyric Text, Bible Text, etc.) 
 
 

 
 

The Edit Ribbon when working with Text Objects. 

The Edit Ribbon when working with Text Objects will give you many common tools. 

The top row from left to right is as follows: 

Font Selection – use this drop down to choose any one of the fonts installed on your computer. 
Font Size – you can select or type any number between 8 and 200 pt. 
Font Color – Use this selection to choose any color for your font. You can also use the eyedropper to select a 
color or manually type in any RGB Hex color value. 
Highlight Color – Use this selection to choose any color for highlighting of text. You can also use the 
eyedropper to select a color or manually type in any RGB Hex color value. 
X and Y – This is the X and Y pixel value of the top left corner of the object. For instance, a resolution setting of 
1280×720 would mean that the top left is X:0 and Y:0 and the bottom right would be X:1280 and Y:720. So, an 
object in the top left corner of the screen could have an X:0 and Y:0 value if the top left corner is exactly in the 
top left of the screen. As a note, the X and Y values follow your resolution settings for the script. In addition, you 
can have negative values or values greater than the screen resolution for the X and Y to move things off-screen. 
However, all objects must keep at least 10 pixels by 10 pixels on the edit area, so you can not move objects 
completely off the edit area and “lose them”. 
W and H – This the Width and Height of the object based on pixels. You can increase or decrease this as 
you prefer to change an object’s size. All Objects have a minimum size of 50 pixels by 50 pixels. 
Lock Aspect Ratio – Between the W and H value is a Lock Aspect Ratio toggle. This will lock the Aspect Ratio                      
if you try resizing an object so that it keeps the same aspect it originally had. With this toggled off, you can                      
adjust an object to be skewed or stretched with regard for the Aspect Ratio. 
Angle – This selection allows you to rotate an object clockwise between 0 and 360 degrees. 0 degrees is the 
default angle. Rotating to 90 degrees will put an object on it’s right side. Rotating to 180 degrees will make the 
object upside down. Rotating to 270 degrees will put an object on it’s left side. Rotating to 360 degrees will place 
the object back to it’s normal angle. 

 
The bottom row from left to right is as follows: 

 
Bring to Front – This button will change the object’s position in the layers by bringing it to the front above all 
other objects. 
 



 
Send to Back – This button will change the object’s position in the layers by sending it to the back behind all 
other objects. Note: this object will still be above the Background Layer which will ALWAYS be the lowest 
layer. 
Bold – This button will toggle the Bold formatting On/Off for the selected text or entire text box (if the box 
is selected). 
Italic – This button will toggle the Italic formatting On/Off for the selected text or entire text box (if the box 
is selected). 
Underline – This button will toggle the Underline formatting On/Off for the selected text or entire text box (if 
the box is selected). 
Strikethrough – This button will toggle the Strikethrough formatting On/Off for the selected text or entire text 
box (if the box is selected). 
Superscript – This button will toggle the Superscript formatting On/Off for the selected text or entire text box (if 
the box is selected). 
Subscript – This button will toggle the Subscript formatting On/Off for the selected text or entire text box (if the 
box is selected). 
All Caps – This button will convert the selected text or entire text box (if the box is selected) to be All Caps. 
Toggling this button again will make all text lower case. Note: when using mixed case (upper and lower case) 
within text, that formatting will be lost when using the All Caps toggle. 
Object Placement – This is a quick placement tool to help you place the selected object in one of nine preset 
locations on your Edit Area. It will physically move the Object to that location, but is an easy way to center your 
text box on your screen quickly. 

Align Text Horizontally – Choose between Left, Center, Right, or Justified Text. 
Align Text Vertically – Choose between Top, Middle, or Bottom. 
Line Spacing – Choose different line spacing options to spread out text vertically for each line break. 
Bullets – Choose one of the various Bullet or Numbering options for lists. 
Decrease Indent – If Text is indented, you can use this tool to remove the indent. 
Increase Indent – Use this tool to shift text within the text box as a whole group for paragraph purposes. 
FX – The FX (Effects) button gives you various advanced controls like Shadow, Outline, Text Box Color, etc. 
for the selected object. 
Presets – Choose a previously saved Preset to apply or create a new Preset with this dropdown. Presets can be 
used for other similar like-objects (a Text Preset can be used on Text Boxes only, for example). 

 
Media Objects (Images, Videos, etc.) 
 

 

 
The Edit Ribbon when working with Media Objects. 
 
The Edit Ribbon when working with Media Objects will give you many common tools you may have noticed 
when working with Text Objects with the exception of some differences. 

 
 
 
 
 
 



 
 
The top row from left to right is as follows: 

 
X and Y – This is the X and Y pixel value of the top left corner of the object. For instance, a resolution setting of 
1280×720 would mean that the top left is X:0 and Y:0 and the bottom right would be X:1280 and Y:720. So, an 
object in the top left corner of the screen could have an X:0 and Y:0 value if the top left corner is exactly in the 
top left of the screen. As a note, the X and Y values follow your resolution settings for the script. In addition, you 
can have negative values or values greater than the screen resolution for the X and Y to move things off-screen. 
However, all objects must keep at least 10 pixels by 10 pixels on the edit area, so you can not move objects 
completely off the edit area and “lose them”. 
W and H – This the Width and Height of the object based on pixels. You can increase or decrease this as 
you prefer to change an object’s size. All Objects have a minimum size of 50 pixels by 50 pixels. 
Lock Aspect Ratio – Between the W and H value is a Lock Aspect Ratio toggle. This will lock the Aspect Ratio                      
if you try resizing an object so that it keeps the same aspect it originally had. With this toggled off, you can                      
adjust an object to be skewed or stretched with regard for the Aspect Ratio. 
Angle – This selection allows you to rotate an object clockwise between 0 and 360 degrees. 0 degrees is the 
default angle. Rotating to 90 degrees will put an object on it’s right side. Rotating to 180 degrees will make the 
object upside down. Rotating to 270 degrees will put an object on it’s left side. Rotating to 360 degrees will place 
the object back to it’s normal angle. 

 
The bottom row from left to right is as follows: 

 
Bring to Front – This button will change the object’s position in the layers by bringing it to the front above all 
other objects. 
Send to Back – This button will change the object’s position in the layers by sending it to the back behind all 
other objects. Note: this object will still be above the Background Layer which will ALWAYS be the lowest 
layer. 
Object Placement – This is a quick placement tool to help you place the selected object in one of nine preset 
locations on your Edit Area. It will physically move the Object to that location, but is an easy way to center your 
text box on your screen quickly. 
Crop – This button allows you to crop your media object (currently only available for images). 
FX – The FX (Effects) button gives you various advanced controls like Shadow, Outline, Color, etc. for 
the selected object (these controls vary by object type). 
Presets – Choose a previously saved Preset to apply or create a new Preset with this dropdown. Presets can be 
used for other similar like-objects (an Image Preset can be used on Images only, for example). 

 
Tips and Tricks with Editing 
 

1. Don’t forget that you can move objects using your arrow keys 1 pixel at a time. If you hold SHIFT 
and press your arrow key, it will move it 10 pixels. 

2. You don’t have to highlight all the text in a text box to edit it. Just click the object to select it and then 
edit in the Edit Ribbon as desired and all the contents will change. 

3. Always remember that the Background Layer (whether it is a Color, Image, or Video) is ALWAYS 
the lowest layer and can’t be moved from that spot. However, you can always layer any other objects 
above the Background as you wish. 

4. You can zoom in and out on your Edit Area using the Zoom Slider in the bottom left of the Edit Area. 
To reset it, simply right-click on the slider bar. 

5. If you use the Stage Display, you can edit the objects on it completely independent of the Main Display. 
To get to the Stage Display in the Edit Area, just toggle the button in the bottom right of the Edit Area. 

 



 
 

6. Undo is your friend! Almost every task you do in MediaShout 7 is undoable. If you make a mistake, 
just Undo it. 

7. Check out the Hot Keys page for tons of other great shortcut controls to help you edit your presentation. 

 
 
 
 

Stage Display 
 
 
 

MediaShout 7’s new and improved Stage Display will give you tools that you won’t find in any other program. 
Before we dig into all of those great tools, let’s talk about what the Stage Display is. 

 
The Stage Display is designed to be an additional video output from your computer for people on the stage 
(Worship Team, Pastor, etc.) who may want to have different content on their screens than what the audience 
sees on the main screen. This allows the team on stage to have additional notes or to hide things (like 
backgrounds) that they don’t need on the stage display. 

 
To use the Stage Display, you need to connect a third monitor output to your computer and in the Settings, 
change the Stage Display to be the display you connected. Once connected you can now configure your stage in 
one of three ways: 

 
1) Mirror Main – In the Viewers Tab at the bottom right, you can toggle the Mirror Main to YES/NO. 
When selected to YES, then the Stage Display will ALWAYS show exactly what is on the Main Display, no 
matter what customization you may have made to the Stage Display. This is a global setting and overrides all 
custom settings. 

 
2) Synchronize Stage – you can do this on a Page by Page basis (in the Edit Area, just right-click on the 
background and choose Synchronize Stage) or for the entire Cue (in the Script, click the Synchronize Stage icon 
under the Thumbnail of the Cue). This will apply all objects from the Main Display to the Stage Display exactly 
as they appear on the Main. NOTE: If you are using different Aspect Ratios from Main to Stage (i.e. a 4:3 
projector for Main and a 16:9 TV for Stage), then your objects may not be in the exact same spot due to changes 
in resolutions. 

 
3) Custom Stage – Taking Step 2 a little bit further allows you to customize the Stage Display by turning 
on/off existing Objects, adding your own Objects, and even changing the Background. This allows you to truly 
customize your Stage Display to show ANYTHING that you want. 

 
Pro Tip: With the new Stage Display capability, you can now have essentially two separate presentations that 
run at the same time, since they can be completely independent. Want to run content for a Triple-Wide 

Environmental projection and side-screen lyrics at the same time? You can with one computer (you will need a 
pretty powerful machine to do this, though). You can also create and send Alpha-Channel content out from the 
Stage Display to your video switcher without needing to have additional hardware. If you don’t know what that 
is, don’t worry – it’s designed for churches using advanced lower-third graphics and motions beyond just a 
Chroma or Luma Key. 

 
 



 
 

 

Settings 
 
 
 

The Settings Window (found in the Menu Bar at the top of MediaShout 7) will give you access to a lot of 
customization of your program. Below, we will talk about each of the sections included. 

 
GENERAL SETTINGS 
 
TEXT OPTIONS 
 
 

 
 
 
 
 

 
 
The first area is the Text Options. At release, we only have the English Language for localization, but we have 
plans in place to release many more. If you are interested in a specific language for MediaShout 7, please let us 
know. This area is also where you can adjust the font size of the Control Screen for the user. The only option at 
release is Normal, but we plan to include additional sizes for various screen resolutions. 

 
ADDITIONAL OPTIONS 
 
 

 
 
 
 

 
 
Here you can toggle on/off the Hint of the Day (that appears when you first launch MediaShout 7) as well as 
turn on the Edit on the Fly feature. This feature will show your changes on your Main Display as you make them 
on the Edit Area without having to refire the page. It can be handy if typing live text based on audience feedback 
for example. 

 



 
SAVE OPTIONS 
 
 

 
 
 
 

 
 
The Save Options give you the ability to set your default Save Folder as well as to turn Autosave on (which will 
autosave open scripts every 10 minutes if they have been saved previously). 

 
REMOTE CONTROL 
 
 

 
 
This is where you will setup and configure USB Remote Controls (and any other USB controller). Plug your 
device into your computer, then click Add New Controller and follow the steps. Once configured, as long as that 
device is plugged into the same USB port on your computer, it will read that as a Remote Control to advance 
your presentations. 
 
 

LIBRARY SETTINGS 
 

 
 
This area is where you will set your Image,Video and Audio Folders that populates the Library Tab of your 
Control Screen. You can choose any folder on your computer and it will then use that to display images or videos 
in the Library Tab. This is also where you can Download all 70 Versions of the Bible. 
 
 
 



 
DISPLAY SETTINGS 
 
SELECT VIDEO OUTPUT 
 
 

 
 

In the Display Settings, you will choose which display is your Main Display, which display is your Stage 
Display, what the default resolutions of your scripts will be, and what to do with objects when changing 
resolutions. 

 
NOTE: As more features are added and settings included, we will do our best to update this specific page. 
However, if you find something in MediaShout 7 that is not described in this Settings article, please let us know 
and we will update it as soon as we can. 

 
 
 

 
 
 
 
 

 
 



 

Creating Your First Script 
 
 
 

Getting Started: 
 
Creating your first script can involve a number of different things. In this section, we are going to cover the 
basics of building a script that most users will find helpful. We won’t get into the deep details or advanced 
editing with this. Instead, we want to make sure you have a solid guide for getting started. If you haven’t 

completed the Installation and Setup (https://www.mediashout.com/docs/mediashout-7-user-guide/getting- 
 started/installation-and-setup/) page yet, we encourage you to do that before building your first script. 
 
With MediaShout 7 open to the Launch Screen, simply click the button for Create a New Script in the top left. 
As a note, you can also go to the File Menu->New Script or use CTRL+N to create a new script. There are many 
more Hot Key Combinations (https://www.mediashout.com/docs/mediashout-7-user-guide/advanced-tools/hot- 

 keys-keyboard-combinations/) like this to make creating and building your presentation very easy. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

The Launch Screen in MediaShout 7 

Creating a new script: 

● When you create your new script, it will be called “Untitled”. You can go ahead and save it by going to 
File->Save, giving it a name in the window that appears and choosing the location, and then saving it. Also, 
just like a web browser, you can have multiple scripts open as tabs (up to 10), which will allow you to jump 
between different presentations as you need. 
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Auto-Save: 
 

One of the new features of MediaShout 7 is the Auto-Save which will automatically save your presentation every 
10 minutes once it is saved the first time. You can turn this off in the Setting Menu if you would like.  
 

● While in the Settings Menu, you can also set default folders for your Image and Video Library. These are 
the folders that will populate the Library Tab (we will use this later on, so don’t worry if you don’t know 
what to make it just yet). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Settings Window 

Now that we have everything setup, we will start by entering our worship songs to begin in our script. 
 
Inserting Lyrics: 
 

● To insert your first lyric, press the Insert Lyric Cue icon in the Main Ribbon.  
 

● Once that window opens, you can search in the top part of the library for name or lyric that follows your 
search criteria. Note: the search will look for exact wording and phrases as you have them typed. You can 
also scroll through your list of lyrics on the left in the All Folder. MediaShout includes a set of Public 
Domain lyrics to get you started, but you can add to those easily by clicking the “+” icon in the bottom 
left or by using the SongSelect service (internet access and SongSelect subscription required). 

 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Insert Lyric Window 
 
You can expand a title of a song to see author and copyright information and use the scroll bar on the right to 
preview the contents of the song. Don’t worry about the formatting at this point, as you will do that in the Edit 
Area of the script. If you want the Copyright Info to show on your Main Display automatically, make sure the 
Copyright toggle is marked Show next to the Insert Lyric button. Pressing the Insert Lyric button in the 
bottom right will add the selected lyric to your script. That’s it. You’ve added your first cue to your script! 

 
 
Create a lyric from scratch: 
 

● If you do have to create a new lyric from scratch, just click the “+” button in the bottom left of the Insert 
Lyric Window to get started. 
 

● Give it a name and click “Add” and it will now be in your library. 
 

● On the left side, you can click to the right of the colons to add Authors and Copyright information, too. 
 

● In the right section, type or copy/paste the lyrics into the first verse (which is automatically created 
when you create the lyric). You don’t have to worry about formatting at this point. 

 
 
Adding stanzas: 
 

● To add more stanzas, choose the stanza type at the bottom you want next and click “Add”. It will 
auto-number your stanzas as needed. Repeat the process for any other stanzas you need to add. 
 

● Once completed, you can adjust the play order by clicking the list view in the top right and then drag 
and drop stanzas as you need or add existing stanzas from the drop down if you need to have them more 
than once. 



 
● Once done, you can click the Insert Lyric to add it to your script. 

 
● While you are at it, go ahead and add a few more songs to your script, so that you have 3 or 4 songs 

inserted. 
 

● Then click the “X” in the top right to close the Window once you are done. Just remember that your 
Insert Lyric Window is designed for creation of lyrics, importing of lyrics, and first time setup of lyrics. 
Once you have inserted the lyric and then begun formatting it (with fonts, styles, backgrounds, etc.) 
then you will save it to the new Cues Library Plug-In for future use. 

 
Editing Lyrics: 
 
Now that we have some lyrics, it is time to format them to look the way we want. The first thing to do is 
add the Background. 
 

● Select one of your lyrics and then click on the Layers Tab of your Control Screen. 
 

● There you will click the Background button below the layers of text. 
 

● From there, you can add a color background, Image/Video or Audio. 
 

● To select one of the media files, just click Image/Video and choose Browse then choose a file from your 
computer. 
 

● Once you have the background selected, click Save Changes to apply it to that cue. You will now notice 
that the background goes through all pages of that cue. 

 
 
Font and font style: 
 

● Now, let’s work on the font and font style. Select the text box in the Edit Area (or in the Layer’s Tab) of 
the text you want to edit. 
 

● Once the text box is selected, you will notice the Edit Ribbon above the Edit Area change to give you 
formatting tools for text. Click any of the options to adjust the font, size, color, or style to your 
preference. You can also adjust alignment or add Outline or Shadow effects by clicking the FX button.  
 

● To apply any changes you have made to this text box to the other stanza text boxes on other pages, just 
right-click on the text box and choose “Apply Formatting to All Pages.”  
 

You can optionally apply Transitions to the Text Box Object or the Page (or even entire Cue) by going to the 
Transition Plug-In on the right, choosing the transition and its settings, and then clicking Apply. Notice that 
there are additional options next to the Apply button to expand the Transition to more than just what is selected. 
 
 
 
 
 
 



 
Finally, you can adjust text on each page and actually force text to a new page by using the Page Break function, 
which is done by placing your cursor where you want the break to occur and then holder CTRL and pressing 
ENTER. This will force the text past the cursor to go to a new page in your stanza. For instance, if you had 8 
lines of text on Verse 1 and decided you wanted to split it into 2 pages with 4 lines each, you could place your 
cursor at line 5 and press CTRL+ENTER and now you have Verse 1a and Verse 1b. If you ever want to remove a                       
Page Break, simply place your cursor at the beginning of the text on the page after the break and hit Backspace to                      
remove it. Your text will join together again. 
 
Ordering stanzas: 
 

● If you need to order your stanzas even after inserting them, you simply drag them around in the Page                   
Area of the Cue in the Script. You can also copy and paste stanzas to add more instances of them. 
 

● If you want to add a blank page (for intro, musical interludes, etc.), click the “+” button below the Cue                    
Thumbnail in the script to add a new page. You can then rename it (by double-clicking on the name) or                    
drag it around to wherever you want the blank page to be. 

 
Once all editing has been finished, we recommend saving the lyric to your Cues Library if you want to use it 
again. To do that, click the Star Icon below the Cue Thumbnail in the script and you will see it light up. Then it 
will be available in your Cues Library with all of the edits ready for the next time you want to use it. 

 
Using Presets to Save Formatting: 
 
You can easily save your formatting styles of a text box for use on other text boxes in the form of Presets. This 
prevents you from having to repetivily format different text boxes the same way over and over. 
 

● To create a Preset, simply select the text box and then click the Presets drop down in the Edit Ribbon 
above the Edit Area. 
 

● Click the “Enter new preset name” area and enter a name for the preset. 
 

● Once you do that a window will appear that will allow you to choose ANY of the available settings to 
save with that Preset. This way, you can be specific about what gets saved to the preset and what doesn’t. 



 

 
Preset Window Options 

 
Apply a preset: 
 

● To apply a saved Preset, simply select another Text Box and click the Preset drop down and choose the 
Preset you want to apply. That’s it. You can save and apply Presets for different object types, too, 
including images and videos. 

 
Combining Presets with the Apply Formatting to All Pages will allow you to format your Cues quickly and 
easily. For each of your lyrics, just follow the above for setting your background and formatting and you are all 
done with lyrics. Let’s move on. 

 
Text and Media Cues: 
 
For preparing for our Sermon Slides, we can use a Blank Cue to start.  
 

● To insert a Blank Cue, click the Blank Cue Icon in the Main Ribbon, give it a name, and then press Create. 
 

 
● Insert a Background just like you did for the lyrics earlier by going to the Layers Tab and clicking 

Background. 
 

● Then, insert a regular Text Box by clicking the Insert Text Box Object icon in the Main Ribbon. 
 

● From there, type any text into the new text box (like a sermon title or point). 
 
 

 



 
● Just like with Lyrics, you can now apply formatting and styles from the Edit Ribbon above the Edit Area. 

As a reminder, you can create Presets for any Text Box formatting that you might be reusing to save 
yourself time. 
 

● Now add another Page to this Cue by clicking the “+” button below the Cue Thumbnail. You can copy the 
text box from the first page and paste it on the second page by using your right-click context menu or the 
Hot Keys CTRL+C (Copy) and CTRL+V (Paste). 

 
You can also add a Media File (like an Image or Video) to this page by clicking the Insert Media icon in the Main 
Ribbon. This will open a Windows Explorer box where you can select any media file on your computer. Once 
inserted, you can resize, crop, or edit it as you wish using the tools in the Edit Ribbon. Note: if your media files 
are in the folder that you set as your Library early on, then you can go to the Library Tab in the Control Screen 
and drag and drop images and videos from the Library Tab directly into the Edit Area to add them as objects.                     
Just like with text boxes, you can also use the FX Window with Images and Videos to add an outline, shadow,                     
or even filters with images. 
 

 
FX Window for Images 
 

These same tools can be used to build additional sermon slides but also Announcements, Offering Slides, and more 
as you need. Also, specifically for Pastors, is our new Sermon Builder Plug-In, which is designed to make it easy 
and fast for a Pastor to build their Sermon Slides in MediaShout without having to know anything about how 
MediaShout works. You can learn more about this tool in the Sermon Builder Plug-In page of this User Guide. 
 
 
 
 
 
 
 
 



 
Inserting Scripture: 
 

● To insert a Bible Cue, click the Insert Bible Cue icon in the Main Ribbon. 
 

● In the window that opens, choose a Translation, Book, and Chapter on the left. When you do that, the 
middle section will populate with all the verses from the selected chapter. You can select one verse at a 
time, use SHIFT to select a group of verses, click Select All to get all the verses, or even choose any verse, 
even non-consecutive ones. You can also type your reference in the top portion of this window if you know 
exactly what scripture you want. 

 

 
 
Insert Bible Window: 
 

● When you are done selecting, click the Insert Bible button in the bottom right. 
 

● You can add additional Bible Cues by doing the same steps or click the “X” in the top right to close the 
Insert Bible Window. 
 

● Once inserted, you can edit the font, style, background, and more just like you did with a lyric. You can 
also save Presets for your Bible Text to use on other Bible Text Boxes throughout your Script. 
 

● Once you have your Sermon Cues and your Scripture Cues (and any other Cues), you can rearrange them 
by simply dragging the Cue Name or Cue Thumbnail in the Script Area and moving the Cue up or down in 
the Script to place it between other Cues. 
 

● Once you have all of the Cues and Pages in the order you want and formatted the way you need, then you 
are ready to Play your presentation. Don’t forget to add any Cues to your Cues Library that you want to use 
again in the future. 

 
That’s it! There are many more tools and features you can use to build, edit, and create with MediaShout 7, but 
we just wanted to cover the basics in this first Script. Now you are ready to move on and play your Script. 

 



 
 

Playing Your First Script 
 
 
 

MediaShout 7 gives you a couple of different ways to play your presentation. You can choose which one 
best suits your needs. 

 
First off, there are two different views of the Control Screen that allow you play your presentation. One is the 
Edit View (the view we have been working in to create your first Script) and the other is the Presenter View. 
To play Cues or Pages in the Edit View, simply click the blue play button under the Cue Thumbnail to fire the 
first Page of the Cue to the displays. If you want to fire a specific page, as you hover over the Page in the Cue, 
you will see a blue play button to the right of the Page name. Click that blue play button to fire that specific 
page to the displays. As a note, clicking anywhere on a page except the blue fire button will select that page in 
the Edit Area but not fire it your displays. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Edit View of Control Screen 
 
You can switch to the Presenter View by going to the View Menu->Mode->Presenter View. You can also use 
the Hot Key CTRL+ALT+V to switch between the two views quickly. While in Presenter View, you can again, 
click the blue play buttons under the Cue Thumbnail or in the Page names in the Script Area on the left, but you 
may find it easier simply double-clicking the Thumbnail of the Page in the middle of the Control Screen. This 
Presenter View is designed to be an easy format for seeing many cues and pages of your script and allows for 
easy firing of any Page at any time. There is a zoom function in the top right that will allow you to adjust the size 
of the Thumbnails in the Presenter View. You can also switch to a text-based list view in the Presenter View that 
is a throwback to MediaShout 5 and earlier days. 

 



 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Presenter View of Control Screen 
 
Once you are playing a Page, you can easily move forward in your presentation using the F9 key or backward 
using the F7 key, no matter which mode you are in. Also, if you have a USB Remote, you can configure that very 
easily in the settings and use the buttons on the remote to go forward and backward through the presentation. 

 
In the bottom right is the Playback Area that has some similar tools as what we’ve discussed already. The Play 
Button will fire the selected Page in the Edit Area. The Stop All button will stop all playback to all displays. The 
Forward and Next buttons will go through your presentation just like you were using F9 or F7. 

 
 

 
Playback Bar 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
If you are ever wondering what is being sent to your displays, you can always use the Viewers Tab on the right 
side of the Control Screen to see what is going to the Main Displays at the top and what is going to the Stage 
Displays at the bottom. The Stage Display section can also toggle to show you what is coming up next on the 
Main Display, if you would rather see that. Also, in the Script Area, there will be a red dot in the top right of the 
cue as well as a red dot next to the page that is currently being displayed. 
 

 
 

Viewers Tab of Control Screen 
 
 

 
 

 
 
 
 

 
 



 

Saving, Exporting, and Printing 
 
 
 

Saving in MediaShout 7: 
 
Once you have created your first script and you want to save it, all you need to do is go to the File Menu->Save 
and then give it a name and choose the location. MediaShout 7 uses a .sc7x extension for the file name. This file 
format not only contains your script, but also all of your media. No longer do you have to worry about keeping 
media files in sync between locations or accidentally deleting or moving a media file that your Script needed. 
Because this is a new type of file, it is not possible to open this format in older versions of MediaShout. 
However, because the media is contained inside the .sc7x file, you simply need to take that file from computer to 
computer if you want to play the presentation on a different computer. 

 
Since saving your script is a pretty common task, we’ve also given it the Hot Key combination of CTRL+S. That 
way, you can save at any time quickly and easily. Additionally, MediaShout 7 includes the new Auto-Save 
feature that is turned on by default. Once a script is saved, it will be auto-saved about every 10 minutes so in 
case you forget and close MediaShout without saving, you won’t lose all your work. You can turn the 
Auto-Save ON/OFF in the Settings Menu. 

 
Additionally, if you want to save your script with a new name and not overwrite your original script, you can                    
go to the File Menu->Save As (CTRL+SHIFT+S). This will allow you to save the script as a new file and leave                     
the original file as it was last saved. 

 
There are other saving functions inside of MediaShout 7. For instance, your Insert Lyric Window contains a 
Lyric Database of lyric titles and contents. Your database is automatically updated and saved each time you edit, 
add, or change a lyric in the Insert Lyric Window. The other automatically saved database is your Cues Library 
in the Cues Library Plug-In. When you close MediaShout 7, this library is automatically saved and updated with 
the Cues you’ve added. It is important to note that Lyrics that have been inserted into a script, edited, and 
formatted should be saved to the Cues Library for future use. Think of the Insert Lyric Window as just another 
library of contents (like SongSelect) where you can find lyrics, but all the formatting changes are saved to the 
Script and Cues Library. 

 
Exporting in MediaShout 7: 
 
MediaShout 7 gives you a lot of Export options for whatever you may need. In the File Menu->Export you are 
given three options: Images, PDF, and Text. As you would expect, each has its own settings allowing you to 
customize exactly what you want to export. 

 
With Export Images, you can choose the location, what cues/pages to include, what type of image (JPEG or 
PNG), what objects/elements, if Titles should be included, and if the Background should be included. If you 
have white text and you don’t include the background, then your text may not appear if it is sitting on a white 
background. 

 
With Export as PDF, you have a very similar selection as Export Images, with a couple of exceptions. With PDF 
there is no file format type to choose, but you do have the ability to choose a layout on your PDF, so you can 
have 1 Page per page of PDF up to 12 Pages per page of PDF. 

 
 



 
With Export as Text, you get a Text File that includes all of the text on each selected page. Each page is                      
labeled and broken up with dashes to easily note the next page. This is a great tool if you need to export lyrics                       
for your worship team or MediaShout operator to have in front of them. Of course, all of these export functions                    
allow you to provide a way for users to see your presentation (in a non- editable format) without needing                   
MediaShout 7 to be installed. 

 
Additionally, you can export your Lyric Database from the Insert Lyrics Window if you want to take that                  
library to a new computer with MediaShout 7. And, although there is no direct way to export the Cues Library,                    
you will actually find it to be a simple .sc7x file that you can simply copy in Windows Explorer to a USB drive                       
to take to another computer. 

 
Printing in MediaShout 7: 
 
Much like the Export options above, the Printing option allows you to choose a number of different settings 
before going to your printer’s control screen. Settings include the Printer, which pages/cues, paper size, Portrait 
or Landscape, Layout, which objects/elements to include, whether the Background is included, and whether or 
not the print is in color or black and white. Like with the Export, if you have white text and choose not to show 
your background, your text may be invisible on the print preview since it will be on a white sheet of paper. 

 
All of the Saving, Exporting, and Printing functions are designed to make it easy for you to share your 
presentation or keep specific copies as you need. 

 
 
 

 
 
 
 
 

 
 



 

Text Boxes 
 
 
 

A Text Box is simply that – a text box. These boxes hold text that is typed or copied/pasted from another source. 
There are three main types of Text Boxes used in MediaShout 7. Let’s talk about each one: 

 
1. A standard Text Box is the text box inserted to your Cue when clicking on the Insert Text Box Object 

in the Main Ribbon. This text box works like you would expect any text box to. You can resize the box, 
adjust fonts and formatting, add shadow and outline, and other standard things. 

2. A linked Text Box is the text box inserted to your Cue when inserting a Lyric or Bible Cue and contain 
the main contents. These text boxes are linked and allow you to create Page Breaks and apply formatting 
to all of the linked boxes throughout the Pages of the Cue. Much like a Standard Text Box, you can 
control the size, fonts, formatting, and more. The main difference is to think of this text box as linked to 
the other main content text boxes on the other Pages of this Cue. 

3. A special Text Box is the text box inserted to your Cue as a Lyric Copyright or Key Object Text Box. 
These Text Boxes will be the same on all pages of a Cue, so any changes you make to this text box on one 
page will be immediately reflected on all other pages. Essentially, this is one text box that is synched 
across multiple pages with any formatting changes. 

 
Using the three types of Text Boxes can help you develop your cues and set formatting quickly and easily. 

 
 

 
 

 
 
 
 

 
 



 

Video Files 
 
 
 

Video Files of various different formats can be inserted into MediaShout 7. These video files can be used as 
Backgrounds using the Layers Tab->Backgrounds button or as media objects layered into the Page by using 
the Insert Media Object icon in the Main Ribbon.  

Videos that are set as a Background, will continually play without restarting through all Pages of the Cue. 
Videos that are set as Objects will appear only on the Page they are inserted. If a Video Object is placed on two 
consecutive Pages, the video will restart when changing from Page to Page. 

 
Inserting Video Objects 
 
You can also insert Video Objects by dragging and dropping from the available files in the Library Tab. The 
Library Tab is populated from a specific folder set in the Settings Menu. Any videos within that folder will 
appear on the Library Tab->Videos Tab. 

 
Adjusting the volume or muting a video 
 
You can also adjust the volume or even mute a video. If you are inserting it as a background, you will find the 
volume controls on the left of the Background Window. If it is inserted as an Object, then clicking on the Video 
in the Edit Area to select it will give you controls for volume at the bottom of the video itself in the Edit Area. 

 
 

 
 

 
 
 
 

 
 



 

Images 
 
 
 

Image Files of various different formats can be inserted into MediaShout 7.  

These Images can be used as Backgrounds using the Layers Tab->Backgrounds button or as media objects 
layered into the Page by using the Insert Media Object icon in the Main Ribbon. Images that are set as a 
Background, will appear behind all Pages of the Cue. Images that are set as Objects will appear only on the 
Page they are inserted. 

 
 
Inserting Image Objects 
You can also insert Image Objects by dragging and dropping from the available files in the Library Tab. The 
Library Tab is populated from a specific folder set in the Settings Menu. Any Image Files within that folder will 
appear on the Library Tab->Images Tab. 

 
 
Cropping Image Objects 
You can also crop any Image Object that is inserted into the Edit Area. To crop an image, select the image in                      
the Edit Area and click the Crop Button in the Edit Ribbon above the Edit Area. Adjust the crop and click                     
Apply to crop it. 

 
 
 

 
 
 
 
 

 
 



 

Layers 
 
 
 

All Objects on a Page are layered with each other. You will find the settings for these layers in the Layers Tab on 
the right side of the Control Screen. The Layers determine which object sits on top of the other objects visually 
when they are in the same space. In the Layers Tab, you will see two sub-tabs – Layers and Keys. Below we will 
explain how the layers are processed with the topmost layer going all the way down to the bottom most layer. 

 
Layer Order (top first): 

 
1. Keys – these are Key Objects from the Key Objects Plug In. They will be the top most layers and when 

you have multiple Key Objects, are layered by the top Key Object in the Layers Tab being above the 
next Key Object in the list and so on. You can never place a Key Object behind a regular layered Object. 

2. Layer – these are the standard Objects found on a Page (like Images, Videos, and Text Boxes). They 
are layered in order from top to bottom in that list. An Object in the Layer list can never be placed 
above a Key Object. 

3. Background – at the bottom of the Layers list of Objects, you will see a button for Background. This is 
the bottom most layer. You can never move an Object below the Background Layer. You will instead 
need to change the Background Layer to something else if you want to change that. Within the 
Background Layer, there are actually two layers – media (images/videos) on top and solid color on 
bottom. Both are 
accessible from the Background Window. If you do not select a Media File to serve as the Background, 
then it will use the selected color (the default is black). If you do select a Media File to be the Background, 
know that the color is still below the Media File in ordering. This actually allows you to adjust the Opacity 
of a Media File that is the Background to let the lower color layer appear through, allowing you to create a 
colored filter effect. 

 

Rearrange Layers: 

Within the Layers Tab, you can rearrange Layers by dragging them up or down in the list. You can also turn a 
layer visually off (without deleting it) by clicking the Eye icon to the left of the layer. You can also lock a layer 
by clicking the lock icon on the right of the layer. Finally, selecting a layer will also allow you to quickly adjust 
the Opacity of the layer using the slider at the top of the Layers Tab. Utilizing these various controls will allow 
you to be creative with your presentations as well as organized. 

 
 

 
 

 
 
 
 

 
 



 

Backgrounds 
 
 
 

If you’ve read the section on Layers, you know that the Background is the lowest Layer of a page in MediaShout 
7. To dig a little deeper into using Backgrounds, simply select a Cue in your script and in the Layers Tab on 
the right of the Control Screen, click the Background button below the Layered Objects. This will open the 
Background Window where you can set your Background and edit it. 

 
In the Background Window, you have three tabs – Color, Image, and Video. The Color Tab will allow you 
to select any solid color (including custom colors or even use the Eyedropper tool to choose a color on your 
computer screen). This color will remain the lowest layer, even if you select an Image or Video file as the 
Background. 

 
The Image Tab will let you select an Image from your default library or you can browse to any file on your 
computer. You can also set its size to Stretch to Fill or Scale to Fill as you prefer. Additional settings include 
Opacity (which combined with the Color can create a nice colored filter), Grayscale, Sepia, Blur, Brightness, and 
Contrast. 

The Video Tab will let you select a Video from your default library or you can browse to any file on your 
computer. You can also set its size to Stretch to Fill or Scale to Fill as you prefer. Additional settings include 
Opacity (which combined with the Color can create a nice colored filter), Speed (from half to double speed), and 
volume controls. 

 
As a note, the Background is fixed for all Pages within a Cue. You can not set multiple backgrounds per Cue. 
However, you can easily add a full-size Video or Image Object immediately above the Background on a single 
Page to create the effect that it is a different background for that Page (even though all it is doing is covering the 
Cue’s actual Background). 

 
 

 
 

 
 
 
 

 
 



 

FX (Effects) 
 
 
 

When selected on an Object in the Edit Area, you can click the FX icon in the Edit Ribbon above the Edit Area to 
apply additional special effects. These can be as simple as a basic Outline or as complex as setting a Text Box 
Background color with Opacity so that your text shows well against the background. 
 
Using An Effect: 
 

● To use an effect, click the name on the left in the window to select the effect. 
● Then on the right side, adjust as you need. You will see the effects update live in the Edit Area as you 

make the changes, so no need to Apply until you are satisfied with the look and are ready to close the FX 
Window. Pro Tip: if you aren’t seeing an FX change like you think it should, then check to make sure 
the effect’s Opacity setting isn’t set to 0 (invisible). 

 
The different effects will vary depending on what type of object you have selected, so try playing with the 
effects by selecting different objects. 

 
 
 

 
 
 
 
 

 
 



 

Presets 
 
 
 

Presets are essentially a micro-save of your formatting and effects settings that you have applied to an object that 
you want to use again on another object.  

To save a Preset of an object: 

● Select the Object, click the Preset dropdown in the Edit Ribbon above the Edit Area and in the top line, 
type a name for the Preset and hit Enter. 

 
The Preset settings window will open and allow you to select exactly which attributes you want to save to the 
Preset. You can save them all or only a few.  
 
To apply a Preset: 
 

● Simply select the object in the Edit Area, then in the Preset dropdown, choose the Preset you want to 
apply from the list. 

 
Presets are tied to Object type, so a saved Preset for a Text Box can only be applied to other Text Boxes. The 
same is true for Image Objects and Video Objects. The Preset dropdown list will only show you Presets that are 
valid for the selected object when you go apply a Preset. 

 
The benefit of Presets is it can save you a lot of time by allowing you to create a formatting look/style that you 
can reuse over and over without having to go through all the formatting changes with every text box each time. 

 
 
 

 
 
 
 
 

 
 



 

Hot Keys (Keyboard Combinations) 
 
 
 

Hot Keys (or Keyboard Combinations) can be a huge time-saver to help you build, create, and play your 
presentation. We have been very intentional with MediaShout 7 to give you tools to help you without needing to 
use your mouse. Check out the ever-growing list below. 

 
Navigating Scripts 
 

 

Inserting Elements (Cues/Objects) 
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Editing Elements 
 

CTRL+C - Copy 
CTRL+X - Cut 
CTRL+V - Paste (with Formatting) 
CTRL+Z - Undo 
CTRL+SHIFT+Z - Redo 
CTRL+A - Select All 

 
Left Arrow - Move Selected Object Left 1 Pixel 
Right Arrow - Move Selected Object Right 1 Pixel 
Up Arrow - Move Selected Object Up 1 Pixel 
Down Arrow - Move  Selected  Object  Down  1 Pixel 
SHIFT+Left Arrow - Move Selected Object Left 10 Pixels 
SHIFT+Right Arrow - Move Selected Object Right 10 Pixels 
SHIFT+Up Arrow - Move Selected Object Up 10 Pixels 
SHIFT+Down Arrow - Move Selected Object Down 10 Pixels 

 
CTRL+Left Arrow - Stretch Object's Left Side 
CTRL+Right Arrow - Stretch Object's Right Side 
CTRL+Up Arrow - Stretch Object's Top Side 
CTRL+Down Arrow - Stretch Object's Bottom Side 
CTRL+SHIFT+Left Arrow - Shrink Object's Left Side 
CTRL+SHIFT+Right Arrow - Shrink Object's Right Side 
CTRL+SHIFT+Up Arrow - Shrink Object's Top Side 
CTRL+SHIFT+Down Arrow - Shrink Object's Bottom Side 

 
ALT+Left Arrow - Rotate Object 15 degrees Counter-clockwise 
ALT+Right Arrow - Rotate Object 15 degrees Clockwise 

 
ESC - Unselects all selected elements 
CTRL+Left Mouse - Selects all clicked items together 
SHIFT+Left Mouse - Selects all items in a series between two clicks 

 
CTRL+B - Toggle Bold on/off for selected Text 
CTRL+I - Toggle Italic on/off for selected Text 
CTRL+U - Toggle Underline on/off for selected Text CTRL+, 
(Comma) - Toggle Subscript on/off for selected Text 
CTRL+. (Period) - Toggle Superscript on/off for selected Text Tab - 
Tabs to the right (when inside a Text Box) 

 
 
 
 
 
 
 
 



 
CTRL+SHIFT+L - Text Left Alignment 
CTRL+SHIFT+C - Text Center Alignment 
CTRL+SHIFT+R - Text Right Alignment 
CTRL+SHIFT+J - Text Justified Alignment 
CTRL+SHIFT+T - Text Vertical Top Alignment 
CTRL+SHIFT+M - Text Vertical Middle Alignment 
CTRL+SHIFT+B - Text Vertical Bottom Alignment 

 
CTRL+ALT+S - Toggles Scale of Media Object through Custom, Full Scal e, Full 
Stretch, and Original 
CTRL++  (Plus Sign) - Zoom In on the Edit Area 
CTRL+- (Minus Sign) - Zoom Out on the Edit Area 
CTRL+ENTER - Inserts a Page Break (when working with paginated Text Boxes like 

in Lyrics or Bibles) 
 
Playback Controls 
 

 

 

 

Plug-Ins 
 
 
 

In MediaShout 7, Plug-Ins are a new modular way of configuring MediaShout to be exactly what you need. You 
can find the installed plug-ins on the far right of the Control Screen (past the Layers/Library/Viewers Tab). 
We’ve included some plug-ins by default, but in the future, we will offer many more available on an as-needed 
basis. That means, you won’t have to install features you won’t use and can access new features and updates to 
those features without having to do a full install of the program. We are starting out with 6 plug-ins (that are 
discussed in more detail over the next few pages) that we think most users will want anyway and as we add 
plug-ins, we will add more information to the user guide for them. 

 
 

 
 

 



 
 

Sermon Builder Plug-In 
 
 
 

The new Sermon Builder Plug-In is designed for Pastors and Leaders who don’t have time to learn a new program 
but want something that is faster, easier, and better looking than PowerPoint. It is also for tech staff and 
volunteers who need to build Sermon Slides quickly and easily in a native MediaShout format. It’s so easy to use 
and in less than 10 minutes, you can have a completed Script for the Sermon. 

 
The Sermon Builder Plug-In is located on the right side of the Control Screen in the Plug-In area. Opening the 
Sermon Builder will launch a wizard that will walk you through 5 easy steps. If you have your sermon notes or 
outline in a digital document, you can easily copy and paste text as needed. 
 

● Clicking “Create” on the first page of the wizard will take you to the Title of your sermon. You can type or 
copy/paste your title here. Click “Next” to continue. 

 
● In this window, type or copy/paste your first point you want to make and then click Add. Repeat this 

process until you have all the points in your presentation done. As you add points, you will see them 
appear on the box on the right. You can delete a point by clicking the trash can to the right. Don’t worry 
about the order right now. You will be able to reorder pages at the end. Once you have all the points, 
click “Next”. 

 
● Now you can choose the scriptures you want to use. Again, choose the translation (available translations 

are based on your license code) and then type in the scripture reference. The format is always Book 
ChapterNumber:Verse(s) (you can input a single verse or a range of verses using “-” or non-consecutive 
verses using “,”). Click the “Add” button to add this reference. Repeat this process for all of your 
scripture references and click “Next”. 

 
● The next step is to choose a theme. We’ve started with 6 themes that you can use (with plans to add many 

more). Each theme has a different look for the Title Page, Sermon Points, and Scripture pages. Choose one 
of the themes (or you can keep it simple with the White Text on Black Background) and click “Next”. 

 
● Last, but not least, adjust the order of your pages and view a preview of each page and click “Create”. 

MediaShout 7 will create a new script with each of these as Cues and Pages. Since this is now a native 
MediaShout script, you can edit, move, resize, and add additional cues, pages, and objects like you 
would any other script. 

That’s how easy it is to use the Sermon Builder Plug-In. 
 
 

 
 

 
 
 
 

 
 



 

Key Objects Plug-In 
 
 
 

A long-time favorite with some newly added features, the Key Objects Plug-In is essentially the Keys from 
previous versions. In MediaShout 7, we’ve made it easier and more seamless to create your keys and have them 
at the ready when you need them. As a note, Keys are the top-most layer and will remain on for all Cues/Pages 
until you turn them off. Clicking on the Key Objects Plug-In will show the following Keys: 

 
1. Clock – a standard Key Object that shows the time (HH:MM) in 12- or 24-hour format. Just like a text                    

box, you can modify where it is located and all formatting and styling of the box in the Edit Area. 
2. Timer – a Count Down or Count Up clock (HH:MM:SS) that can show a count down from a specific time                    

or a count up from 0 to a specific time. When the time is reached, you can either have the Timer                     
disappear or simply stop and remain there. 

3. General Text – this is a text box usually designed to send a message to the Displays for Nursery                   
numbers, Announcements, and other messages. Just type in the text you want and you are all set. 

4. News Ribbon – Like the General Text, this is a text box, with one major exception: the text will scroll 
from right to left. This will give you the opportunity to create scrolling text for announcements along the 
bottom while displaying other Announcement Cues on the screen. You can also control the speed of the 
scroll, as well. 

5. Logo – This is simply an image or video file that you want to remain on the screen. Many times, 
this would be a church logo or something similar if you want to have that up on all pages of your 
script without having to add that object to every single page. 

 
● In the Keys Object Plug-In, selecting the name of the Key will allow you to click the “+” button to add that 

type of Key. You can add as many keys as you want of a single type (if you wanted to have 20 countdown 
clocks pre- prepped, you could do that – just make sure you double-click their names in the Layers Tab 
and label them all so you know which is which).  
 

○ If you want to display a key immediately while in the Plug-In window, just click the checkbox to 
the left and it will turn on all keys of that type (this is really designed for the General Text to be 
able to display the text quickly without having to go back to the editor). 
 

○ If you want to edit the Key, once you have added it via the “+” button and configured it the way 
you want in the window, then close the Key Object Plug-In window and go to the Layers 
Tab->Key Objects Tab. There you will see all the Key Objects you added from the Plug-In. Just 
select an object in the layers to edit it as you need (including resizing, formatting, FX, etc.).  
 

● Once you have it designed the way you want, then you simply need to click the Eye icon to the left of the 
Key to turn it ON/OFF. For Clock, Timer, and News Ribbon Keys, you also have a play/pause toggle as 
well as restart icon. 

 
 

 
 

 
 
 
 



 

 

Cues Library Plug-In 
 
 
 

The Cues Library Plug-In is a new feature in MediaShout 7, but it reaches back to our previous Cues Deck for 
long-time MediaShout users. However, we have taken it to a new level in that all the Cues that you want to be 
saved for future use (announcements, lyrics, sermon title slides) are all now saved to the Cues Library. If you 
insert a Lyric and format it in the Edit Area the way you want and you want to save that for future use, you 
simply click the Star Icon under the Cue Thumbnail in the script and it will add it to your Cues Library. You can 
do this for any Cue in your script. 

 
To use the Cues Library 
 

● Click the Cues Library Plug-In (Star Icon) and search for any cue. You can also filter by Lyric, Bible, or 
General Cue Type.  
 

● Once you find the Cue you want, select it and click the Insert Button in the bottom right and the Cue is 
added to your script. It’s that easy. 

 
 
 

 
 
 
 
 

 
 



 

Transitions Plug-In 
 
 
 

Transitions are a great tool to use for making Objects and Pages appear as you move through your presentation. 
The default transition is Cut, but you have a number of additional transitions that you can apply. 

Applying a Transition to an Object: 
 

● Select the Object in the Edit Area and open the Transition Plug-In.  
● Choose the Object Tab. There you can choose the type of transition, additional effects (like direction), and 

more. The Duration option is how long the transition takes to complete. You can also add a Delay (how 
long it waits to begin the transition after coming to the page). You can also use Steps to create builds of 
different objects within a page. For instance, a Step of 0 would show the Object as soon as the Page 
displays. A Step of 1 would require another advance (F9 for instance) for that object to show. A Step of 2 
would require 2 advances.  

● You can then apply the settings to the single object, all objects on the page, or all objects on the cue. 
 

Applying a Transition to a Page/Pages:’ 

 
● Select a Page in the Script and open the Transition Plug-In.  
● Choose the Pages Tab. There you can choose the type of transition, additional effects (like direction), 

and the duration, which is how long the transition takes to complete.  
● You can then apply the transition to the selected page, all pages in the cue, or all pages in the script. 

 
As an important note, if a transition besides cut is applied to a page, then object transitions on that page will be 
ignored (unless they use steps). That means that if you set a dissolve transition for a page, then all objects on that 
page will also dissolve when they transition. 

 
 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

Script Scenario Plug-In 
 
 
 

In Previous versions of MediaShout, we had a Script Control cue that would allow you to set up Loops or skip 
around in the Script. In MediaShout 7, we have added the Script Scenario Plug-in that allows you to accomplish 
this same task. 

Using the Script Scenario Plug-In to set Auto-Advance 
 

● Select the Cue in the Script Area and open the Script Scenario Plug-In.  
● Check the Box for “Automatically advance pages of current cue every __ seconds. 
● Set the seconds that you want this cue to show for before it advances to the next cue/page. That’s it! 

 

Using the Script Scenario Plug-In to set a Loop (Announcement Loop, slideshow of pictures, etc.) 
 

● Select the LAST Cue that is apart of this Loop in the Script Area and open the Script Scenario 
Plug-In.  

● Check the Box for “Automatically advance pages of current cue every __ seconds. 
● Set the seconds that you want this cue to show for before it advances to the next cue/page. 
● Then, also Check the Box for “After the current cue play NONE cue” 
● Click on the word NONE. (This will show a list of the cues in your script). 
● Choose the Cue that you want it to advance to after this current cue is finished 



 

Fire Control Plug-In 
 
 
 

In previous versions of MediaShout, there was a timeline that would show the current video/audio playing on the 
screen. In MediaShout 7, we created the Fire Control Plug-In for this.  

● When a cue is fired with an audio file or a video file attached, you can click the Fire Control Plug-In 
Button and choose Audio or Video to see the timeline of that file and fast forward/rewind/pause/start. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 



 

Legal Notes (EULA) 
 
 
 

Important! You must read and accept this agreement before proceeding with installation of the MediaShout 
Software. 

 
This is an End-User Software License Agreement (“Agreement”) between WordSmith LLC d/b/a MediaShout 
(“Company”) and a single end-user (“Licensee” or “you”) governing the use of the Company’s proprietary 
MediaShout software (“Software”). Nothing in this Agreement shall be deemed to confer any third-party rights 
or benefits. 

 
The Software is a licensed software product, and your rights are limited and restricted to those set forth in this 
Agreement. Downloading or installing the Software constitutes your acceptance of the Software and the terms of 
this Agreement. If you do not agree to be bound by each of the terms and conditions of this Agreement, you may 
not download or install the Software. The Software is available only to Licensees who can form legally binding 
contracts under applicable law. By installing the Software, you represent and warrant that you are (i) at least 
eighteen (18) years of age, (ii) otherwise recognized as being able to form legally binding contracts under 
applicable law, or (iii) are not a person barred from purchasing or receiving the Services found under the laws of 
the United States or other applicable jurisdiction. If you are entering into this Agreement on behalf of a 
corporate entity, you represent and warrant that you have the legal authority to bind such corporate entity to the 
terms and conditions contained in this Agreement, in which case the terms “you”, “your”, “Licensee” shall refer 
to such corporate entity. If, after your acceptance of this Agreement, Company finds that you do not have the 
legal authority to bind such corporate entity, you will be personally responsible for the obligations contained in 
this Agreement, including, but not limited to, the payment obligations. Company shall not be liable for any loss 
or damage resulting from Company’s reliance on any instruction, notice, document or communication 
reasonably believed by Company to be genuine and originating from an authorized representative of your 
corporate entity. If there is reasonable doubt about the authenticity of any such instruction, notice, document                
or communication, Company reserves the right (but undertakes no duty) to require additional authentication              
from you. 

 
This Agreement permits you to install the Software on as many computers that your license allows, to be used 
solely by you for the creation, management and/or delivery of your presentations and media. Under no 
circumstances are you permitted to install or use the Software on more computers than the license allows 
without purchasing a license to do so. This Agreement also permits you to download and/or use one copy of the 
printed Software instructions (“Software Documentation”). 

 
You acknowledge that all rights to the Software and Software Documentation are owned by the Company and 
that the Software and Software Documentation are protected by U.S. and international copyright law. The 
Company retains title and ownership of the Software and any authorized copy of the Software, regardless of the 
form or media in or on which the original and other copies may exist. You may not distribute or copy the 
Software except that you may either (a) make one copy of the Software solely for backup purposes, or (b) 
transfer the Software to a single disk provided you keep the original solely for backup purposes. You may not 
sell, give, or otherwise transfer the Software to any other person or entity without the prior written consent of 
the Company. You may not copy the Software Documentation. 

 
You agree not to modify, adapt, translate, reverse engineer, decompile or disassemble or create derivative               
works based on the Software. 

 
The Software is covered by a limited warranty that it will operate as described by the Software Documentation.                  



 
This limited warranty is effective for a period of thirty (30) days only from the date of delivery as evidenced by                     
a copy of your receipt. The Company does not and cannot warrant the performance of results you may obtain by 

 



 
using the Software. This Limited Warranty is void if the failure of the Software has resulted from accident, 
abuse, misapplication, or hardware error. 

 
THE COMPANY DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING 
BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON- 
INFRINGEMENT, AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE 
SOFTWARE AND SOFTWARE DOCUMENTATION. Your sole and exclusive remedy and the 
Company’s entire liability to you under this Agreement shall be to replace your copy of the Software or return 
any license fees paid to the Company for use of the Software, at the Company’s option. IN NO EVENT 
SHALL THE 

COMPANY BE LIABLE FOR ANY CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, 
WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 
INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSSES) 

ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE AND SOFTWARE 
DOCUMENTATION, EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. Because some jurisdictions do not allow the exclusion or limitation of liability for 
consequential or incidental damages, the above limitation may not apply to you. 

 
You agree to protect, defend, indemnify and hold harmless Company from and against any and all claims, 
demands, costs, expenses, losses, liabilities and damages of every kind and nature (including, without limitation, 
reasonable attorneys’ fees) imposed upon or incurred by Company directly or indirectly arising from (i) your use 
of the Software; (ii) your violation of any provision of this Agreement or the policies or agreements which are 
incorporated herein; and/or (iii) your violation of any third-party right, including without limitation any 
intellectual property or other proprietary rights. The indemnification obligations under this section shall survive 
any termination or expiration of this Agreement or your use of the Software. 

 
The Software and Software Documentation licensed under this Agreement may be subject to U.S. export control 
laws and may be subject to export or import regulations in other countries. You agree to comply strictly with 
these laws and all other laws and regulations applicable to the use or distribution of software. You acknowledge 
that you have the responsibility to obtain any licenses to export, re-export, or import as may be required after 
delivery of the Software to you. By the use of the Software, you acknowledge that you have read this agreement, 
understand it and that it is the complete and exclusive statement of your Agreement with the Company which 
supersedes any prior agreement oral or written and any other communications between the Company, its 
suppliers, or other agents and you relating to the subject matter of this Agreement and that your obligations 
under this Agreement shall inure to the benefit of the Company. No variation of the terms of this Agreement 
will be enforceable against the Company unless the Company gives its express consent in writing signed by an 
authorized officer of the Company. A printed version of this Agreement shall be admissible in judicial or 
administrative proceedings to the same extent and subject to the same conditions as other business documents 
and records originally generated and maintained in printed form. This Agreement shall be governed by and 
construed in accordance with the laws of the State of Tennessee, excluding its conflicts of law rules, and the 
United States of America. For all purposes of this Agreement, the parties consent to exclusive jurisdiction and 
venue in the United States Federal Courts or state courts located in the Middle District of Tennessee or 
Williamson County, Tennessee. 

Company, in its sole and absolute discretion, may change or modify this Agreement, and any policies or 
agreements which are incorporated herein, at any time, and such changes or modifications shall be effective 
immediately. 
 

 
 



 
 



 

Copyright Notice 
 
 
 

MediaShout 7 – Copyright © 2019 Wordsmith, LLC, Franklin, TN 

Bible Copyrights: 

ENGLISH 

American Standard Version (ASV) – Public Domain 
Amplified Bible (Classic Edition) (AMP) – Copyright © 1954, 1958, 1962, 1964, 1965, 1987 by The Lockman 
Foundation, La Habra, CA 90631. Also Copyright 1987 by Zondervan. All rights reserved. 

Bible in Basic English (BBE) – Public Domain 
Christian Standard Bible (CSB) – Copyright © 2017 by Holman Bible Publishers. Used by permission.               
Christian Standard Bible®, and CSB® are federally registered trademarks of Holman Bible Publishers, all rights               
reserved. Common English Bible (CEB) – Copyright © 2011 by Common English Bible. All rights reserved. 

Contemporary English Version (CEV) – 2nd Edition. Copyright © 2006 by American Bible Society. All Rights 
Reserved. 

Darby’s English Translation (DET) – Public Domain 
Douay-Rheims Version (DRV) – Public Domain 
English Standard Version (ESV) – Copyright © 2001 Crossway Bibles, a publishing ministry of Good News 
Publishers. All rights reserved. 

Geneva Bible 1599 (GB) – Geneva Bible, 1599 Edition. Published by Tolle Lege Press. All rights reserved. 
Good News Translation (GNT) – (Today’s English Version. Second Edition) Copyright © 1992 American Bible 
Society. 
GOD’S WORD (GW) – Copyright © 1995 God’s Word to the Nations Bible Society. Used by permission of 
Baker Publishing Group. 

Hebrew Names Version (HNV) – Public Domain 
Holman Christian Standard Bible (HCSB) – Copyright © 1999, 2000, 2002, 2003, 2009 by Holman Bible 
Publishers. Used with permission by Holman Bible Publishers, Nashville, Tennessee. All rights reserved. 
International Children’s Bible (ICB) – Copyright © 1986 Thomas Nelson. All rights reserved. 

King James Version (KJV) – Public Domain 
Literal Translation of the Holy Bible (LIT) – Copyright © Jay P. Green, Sr., 2001 
Modern King James Version (MKJV) – Copyright © Jay P. Green, Sr., 1999 
New American Bible (NAB) – Copyright © 1991, 1986, 1970 Confraternity of Christian Doctrine, Inc., 
Washington, DC. All rights reserved. 

New American Standard Bible (NASB) – Copyright © 1960, 1962, 1963, 1968, 1971, 1972, 1973, 1975, 1977, 
1995 by The Lockman Foundation. Used by permission. 
New Century Version (NCV) – Copyright © 1987, 1988, 1991 by Word Publishing, a division of Thomas Nelson, 
Inc. Copyright © 2005 by Thomas Nelson. Used by permission. All rights reserved. 

New English Translation (NET) – Copyright ©1996-2006 by Biblical Studies Press, L.L.C. All rights reserved. 
Holy Bible, New International Reader’s Version (NIrV) – Copyright © 1995, 1996, 1998 by Biblica, Inc.®. Used 
by permission. All rights reserved worldwide. 

Holy Bible, New International Version 2011 (NIV2011) – Copyright © 1973, 1978, 1984, 2011 by Biblica, Inc.® 
Used by permission. All rights reserved worldwide. 
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